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Creating Documents 
with Word 2013

Word 2013 Unit A

CASE You have been hired to work in the Marketing Department at Quest Specialty 
Travel (QST), a tour company that specializes in cultural tourism and adventure 

travel. Shortly after reporting to your new office, Ron Dawson, the vice president of marketing, asks 
you to use Word to create a memo to the marketing staff and a letter to one of the tour hosts. 

•	 Understand word 
processing software

•	 Explore the Word window

•	 Start a document

•	 Save a document

•	 Select text

•	 Format text using the Mini toolbar and 
the Ribbon

•	 Use a document template

•	 Navigate a document

Unit Objectives
After completing this unit, you will be able to:

Files You Will Need
WD A-1.docx
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Creating Documents with Word 2013Word 2

Word 2013

UNIT A

Learning 
Outcomes
•	Identify the 
features of Word

•	State the benefits 
of using a word 
processing 
program

Understand Word Processing 
Software
A word processing program is a software program that includes tools for entering, editing, and 
formatting text and graphics. Microsoft Word is a powerful word processing program that allows you to 
create and enhance a wide range of documents quickly and easily. Figure A-1 shows the first page of a 
report created using Word and illustrates some of the Word features you can use to enhance your 
documents. The electronic files you create using Word are called documents. One of the benefits of using 
Word is that document files can be stored on a hard disk, flash drive, sky drive, or other storage device, 
making them easy to transport, exchange, and revise. CASE  Before beginning your memo to the 
marketing staff, you explore the editing and formatting features available in Word. 

You can use Word to accomplish the following tasks:
•	 Type and edit text

The Word editing tools make it simple to insert and delete text in a document. You can add text to the 
middle of an existing paragraph, replace text with other text, undo an editing change, and correct typing, 
spelling, and grammatical errors with ease.

•	 Copy and move text from one location to another
Using the more advanced editing features of Word, you can copy or move text from one location and insert 
it in a different location in a document. You also can copy and move text between documents. This means 
you don’t have to retype text that is already entered in a document. 

•	 Format text and paragraphs with fonts, colors, and other elements
The sophisticated formatting tools in Word allow you to make the text in your documents come alive. You 
can change the size, style, and color of text, add lines and shading to paragraphs, and enhance lists with 
bullets and numbers. Creatively formatting text helps to highlight important ideas in your documents. 

•	 Format and design pages 
The page-formatting features in Word give you power to design attractive newsletters, create powerful 
résumés, and produce documents such as research papers, business cards, brochures, and reports. You can 
change paper size, organize text in columns, and control the layout of text and graphics on each page of a 
document. For quick results, Word includes preformatted cover pages, pull quotes, and headers and footers, 
as well as galleries of coordinated text, table, and graphic styles. If you are writing a research paper, Word 
makes it easy to manage reference sources and create footnotes, endnotes, and bibliographies.

•	 Enhance documents with tables, charts, graphics, screenshots, and videos
Using the powerful graphics tools in Word, you can spice up your documents with pictures, videos, 
photographs, screenshots, lines, shapes, and diagrams. You also can illustrate your documents with tables 
and charts to help convey your message in a visually interesting way. 

•	 Use Mail Merge to create form letters and mailing labels
The Word Mail Merge feature allows you to send personalized form letters to many different people. You can 
also use Mail Merge to create mailing labels, directories, e-mail messages, and other types of documents.

•	 Share documents securely 
The security features in Word make it quick and easy to remove comments, tracked changes, and unwanted 
personal information from your files before you share them with others. You can also add a password or a 
digital signature to a document and convert a file to a format suitable for publishing on the Web. 

details
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Before you create a new document, it’s a good idea to spend 
time planning it. Identify the message you want to convey, the 
audience for your document, and the elements, such as tables 
or charts, you want to include. You should also think about the 
tone and look of your document—are you writing a business 
letter, which should be written in a pleasant, but serious tone 
and have a formal appearance, or are you creating a flyer that 
must be colorful, eye-catching, and fun to read? The purpose 

and audience for your document determine the appropriate 
design. Planning the layout and design of a document involves 
deciding how to organize the text, selecting the fonts to use, 
identifying the graphics to include, and selecting the format-
ting elements that will enhance the message and appeal of the 
document. For longer documents, such as newsletters, it can 
be useful to sketch the layout and design of each page before 
you begin. 

Planning a document

Figure A-1: A report created using Word

Add headers 
to every page

Insert 
graphics

Format the 
size and 

appearance 
of text 

Create tables

Create 
columns 

of text

Add lines

Create charts

Align text in 
paragraphs 
evenly

Add page 
numbers in 
footers

Add bullets 
to lists
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Word 2013

UNIT A

Learning 
Outcomes
•	Identify elements 
of the Word 
program window

Explore the Word Window
When you start Word, the Word start screen opens. It includes a list of recently opened documents and a 
gallery of templates for creating a new document. CASE  You open a blank document and examine the 
elements of the Word program window. 

1.	 Start Word, then click Blank document
A blank document opens in the Word program window, as shown in Figure A-2. The blinking vertical 
line in the document window is the insertion point. It indicates where text appears as you type.

2.	 Move the mouse pointer around the Word program window
The mouse pointer changes shape depending on where it is in the Word program window. You use pointers 
to move the insertion point or to select text to edit. Table A-1 describes common pointers in Word.

3.	 Place the mouse pointer over a button on the Ribbon
When you place the mouse pointer over a button or some other elements of the Word program window, a 
ScreenTip appears. A ScreenTip is a label that identifies the name of the button or feature, briefly describes its 
function, conveys any keyboard shortcut for the command, and includes a link to associated help topics, if any.

Using Figure A-2 as a guide, find the elements described below in your program window:
•	 The title bar displays the name of the document and the name of the program. Until you give a new 

document a different name, its temporary name is Document1. The left side of the title bar contains the 
Quick Access toolbar, which includes buttons for saving a document and for undoing, redoing, and 
repeating a change. You can modify the Quick Access toolbar to include the commands you use frequently. 
The right side of the title bar contains the Microsoft Word Help button, which you use to access the 
Word Help system, the Ribbon Display Options button, which you use to hide or show the Ribbon and 
tabs, the resizing buttons, and the program Close button. 

•	 The File tab provides access to Backstage view where you manage files and the information about 
them. Backstage view includes commands related to working with documents, such as opening, printing, 
and saving a document. The FILE tab also provides access to your account and to the Word Options dialog 
box, which is used to customize the way you use Word. 

•	 The Ribbon contains the Word tabs. Each tab on the Ribbon includes buttons for commands related to 
editing and formatting documents. The commands are organized in groups. For example, the Home tab 
includes the Clipboard, Font, Paragraph, Styles, and Editing groups. 

•	 The document window displays the current document. You enter text and format your document in the 
document window. 

•	 The rulers appear in the document window in Print Layout view. The horizontal ruler displays left and 
right document margins as well as the tab settings and paragraph indents, if any, for the paragraph in which 
the insertion point is located. The vertical ruler displays the top and bottom document margins.

•	 The vertical and horizontal scroll bars are used to display different parts of the document in the 
document window. The scroll bars include scroll boxes and scroll arrows, which you use to scroll.

•	 The status bar displays the page number of the current page, the total number of pages and words in the 
document, and the status of spelling and grammar checking. It also includes the view buttons, the Zoom 
slider, and the Zoom level button. You can customize the status bar to display other information.

•	 The view buttons on the status bar allow you to display the document in Read Mode, Print Layout, or 
Web Layout view.

•	 The Zoom slider and the Zoom level button provide quick ways to enlarge and decrease the size of the 
document in the document window, making it easy to zoom in on a detail of a document or to view the 
layout of the document as a whole.

steps

If the Ribbon is 
hidden, click the 
Ribbon Display 
Options button on 
the title bar, then 
click Show Tabs and 
Commands.

TROUBLE

To display a different 
tab, you simply click 
its name on the 
Ribbon.

QUICK TIP

Click the View tab, 
then click the Ruler 
check box in the 
Show group to 
display the rulers if 
they are not already 
displayed.

TROUBLE

details

C8395_UnitA_ptg01_hr_001-024.indd   4 3/4/13   12:14 PM

Prop
ert

y o
f C

en
ga

ge
 Le

arn
ing



Creating Documents with Word 2013 Word 5

W
ord 2013

Table A-1: Common mouse pointers in Word

name pointer use to

I-beam pointer Move the insertion point in a document or to select text

Click and Type 
pointers, including 
left-align and 
center-align

 Move the insertion point to a blank area of a document in Print Layout or 
Web Layout view; double-clicking with a Click and Type pointer automatically applies the 
paragraph formatting (alignment and indentation) required to position text or a graphic 
at that location in the document

Selection pointer Click a button or other element of the Word program window; appears when you point to 
elements of the Word program window

Right-pointing 
arrow pointer

Select a line or lines of text; appears when you point to the left edge of a line of text in the 
document window

Hand pointer Open a hyperlink; appears when you point to a hyperlink in a task pane or when you press 
[Ctrl] and point to a hyperlink in a document

Hide white 
space pointer

Hide the white space in the top and bottom margins of a document in Print Layout view

Show white 
space pointer

Show the white space in the top and bottom margins of a document in Print Layout view

Figure A-2: Elements of the Word program window

Quick Access 
toolbar

File tab

Vertical 
ruler

Tab

Status 
bar

Ribbon

Document 
window

Horizontal ruler

Title bar

Group

Insertion point

Ribbon Display 
Options button

Microsoft 
Office Word 
Help button

Scroll box

I-beam pointer

View buttons Zoom slider Zoom level

Scroll arrow
Vertical 
scroll bar

©
 2

01
4 

Ce
ng

ag
e 

Le
ar

ni
ng

 

C8395_UnitA_ptg01_hr_001-024.indd   5 3/4/13   12:14 PM

Prop
ert

y o
f C

en
ga

ge
 Le

arn
ing



Creating Documents with Word 2013Word 6

Word 2013

UNIT A

Learning 
Outcomes
•	Type and edit text 

Start a Document
You begin a new document by simply typing text in a blank document in the document window. Word uses 
word wrap, a feature that automatically moves the insertion point to the next line of the document as you 
type. You only press [Enter] when you want to start a new paragraph or insert a blank line. CASE  You 
type a quick memo to the marketing staff. 

1.	Type Quest Specialty Travel, then press [Enter] twice
Each time you press [Enter] the insertion point moves to the start of the next line. 

2.	Type TO:, then press [Tab] twice
Pressing [Tab] moves the insertion point several spaces to the right. You can use the [Tab] key to align the 
text in a memo header or to indent the first line of a paragraph. 

3.	Type QST Managers, then press [Enter]
The insertion point moves to the start of the next line.

4.	Type:	 FROM: [Tab] [Tab] Ron Dawson [Enter]
	 	 DATE: [Tab] [Tab] March 13, 2016 [Enter]
	 	 RE: [Tab] [Tab] Marketing Meeting [Enter] [Enter]

Red or blue wavy lines may appear under the words you typed, indicating a possible spelling or grammar 
error. Spelling and grammar checking is one of the many automatic features you will encounter as you type. 
Table A-2 describes several of these automatic features. You can correct any typing errors you make later.

5.	Type The next marketing staff meeting will be held on the 17th of March at 2 p.m. in 
the conference room on the ground floor., then press [Spacebar]
As you type, notice that the insertion point moves automatically to the next line of the document. You also 
might notice that Word automatically changed “17th” to “17th” in the memo. This feature is called 
AutoCorrect. AutoCorrect automatically makes typographical adjustments and detects and adjusts typing 
errors, certain misspelled words (such as “taht” for “that”), and incorrect capitalization as you type. 

6.	Type Heading the agenda will be the launch of our new Borneo Explorer Trek, a 
rigorous ten-day tour of the dense jungles, deep caves, and remote villages of 
Borneo’s northern coast, scheduled for September 2017.
When you type the first few characters of “September,” the Word AutoComplete feature displays the 
complete word in a ScreenTip. AutoComplete suggests text to insert quickly into your documents. You 
can ignore AutoComplete for now. Your memo should resemble Figure A-3. 

7.	Press [Enter], then type Kai Haketa is in Kuching hammering out the details. A prelimi-
nary draft of the tour brochure is attached. Bring your creative ideas for launching this 
exciting new tour to the meeting.
When you press [Enter] and type the new paragraph, notice that Word adds more space between the para-
graphs than it does between the lines in each paragraph. This is part of the default style for paragraphs in 
Word, called the Normal style. 

8.	Position the  pointer after for (but before the space) in the last sentence of the first 
paragraph, then click to move the insertion point after “for”

9.	Press [Backspace] three times, then type to depart in
Pressing [Backspace] removes the character before the insertion point.

10.	Move the insertion point before staff in the first sentence, then press [Delete] six times 
to remove the word “staff” and the space after it
Pressing [Delete] removes the character after the insertion point. Figure A-4 shows the revised memo.

If you press the 
wrong key, press 
[Backspace] to erase 
the mistake, then 
try again.

TROUBLE

steps

Wavy lines and other 
automatic feature 
markers appear on 
screen but do 
not print.

QUICK TIP

To reverse an 
AutoCorrect adjust-
ment, immediately 
click the Undo 
button  on the 
Quick Access toolbar.

TROUBLE

If you want uniform 
spacing between 
lines and para-
graphs, apply the No 
Spacing style to the 
document by click-
ing the No Spacing 
button in the Styles 
group on the Home 
tab before you begin 
to type. Alternatively, 
select the text and 
then click the No 
Spacing button.

QUICK TIP
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Table A-2: Automatic features that appear as you type in Word

feature what appears to use

AutoComplete A ScreenTip suggesting text to insert 
appears as you type

Press [Enter] to insert the text suggested by the ScreenTip; 
continue typing to reject the suggestion

AutoCorrect A small blue box appears when you 
place the pointer over text corrected by 
AutoCorrect; an AutoCorrect Options 
button appears when you point to the 
blue box

Word automatically corrects typos, minor spelling errors, and 
capitalization, and adds typographical symbols (such as © and ™) 
as you type; to reverse an AutoCorrect adjustment, click the 
AutoCorrect Options list arrow, then click the option that will 
undo the action

Spelling and Grammar A red wavy line under a word indicates a 
possible misspelling or a repeated word; a 
blue wavy line under text indicates a 
possible grammar error

Right-click red- or blue-underlined text to display a shortcut menu 
of correction options; click a correction option to accept it and 
remove the wavy underline

Figure A-3: Memo text in the document window 

Memo title

Blank lines between 
paragraphs

Memo header

Text wraps to the next line 
(yours might wrap differently)

Figure A-4: Edited memo text

Text inserted 
in the memo

Normal style leaves 
more space between 

paragraphs than 
between lines

Red, wavy underline indicates 
a possible spelling error

No Spacing style creates uniform 
space between lines and paragraphs
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Word 2013

UNIT A

Learning 
Outcomes
•	Save a file using 
a descriptive 
filename

•	Use the Save As 
dialog box

Save a Document
To store a document permanently so you can open it and edit it at another time, you must save it as a file. 
When you save a document you give it a name, called a filename, and indicate the location where you want 
to store the file. Files created in Word 2013 are automatically assigned the .docx file extension to distinguish 
them from files created in other software programs. You can save a document using the Save button on the 
Quick Access toolbar or the Save command on the File tab. Once you have saved a document for the first time, 
you should save it again every few minutes and always before printing so that the saved file is updated to reflect 
your latest changes. CASE  You save your memo using a descriptive filename and the default file extension.

1.	 Click the Save button  on the Quick Access toolbar 
The first time you save a document, the Save As screen opens. The screen displays all the places you can save 
a file to, including SkyDrive, your computer, or a different location. 

2.	 Click Computer in the Save As screen, then click Browse
The Save As dialog box opens, as shown in Figure A-5. The default filename, Quest Specialty Travel, appears 
in the File name text box. The default filename is based on the first few words of the document. The default 
file type, Word Document, appears in the Save as type list box. Table A-3 describes the functions of some of 
the buttons in the Save As dialog box.

3.	 Type WD A-Borneo Tour Memo in the File name text box
The new filename replaces the default filename. Giving your documents brief descriptive filenames makes it 
easier to locate and organize them later. You do not need to type .docx when you type a new filename. 

4.	 Navigate to the location where you store your Data Files 
You can navigate to a different drive or folder in several ways. For example, you can click a drive or folder in 
the Address bar or the navigation pane to go directly to that location. Click the double arrow in the Address 
bar to display a list of drives and folders. You can also double-click a drive or folder in the folder window to 
change the active location. When you are finished navigating to the drive or folder where you store your 
Data Files, that location appears in the Address bar. Your Save As dialog box should resemble Figure A-6. 

5.	 Click Save
The document is saved to the drive and folder you specified in the Save As dialog box, and the title bar 
displays the new filename, WD A-Borneo Tour Memo.docx.

6.	 Place the insertion point before conference in the first sentence, type large, then 
press [Spacebar]
You can continue to work on a document after you have saved it with a new filename. 

7.	 Click 
Your change to the memo is saved. After you save a document for the first time, you must continue to save 
the changes you make to the document. You also can press [Ctrl][S] to save a document.

steps

If you don’t see the 
extension .docx as 
part of the filename, 
the setting in 
Windows to display 
file extensions is 
not active.

TROUBLE

Microsoft SkyDrive is a free file hosting service that allows you to 
save and sync files to a “cloud” and then access them from any 
computer that is connected to the Internet. The files you save to 
Microsoft SkyDrive are available only to the people you grant 
access, and every file you store on Microsoft SkyDrive is automati-
cally synced so that you can get the most up-to-date version of 
your files from any computer. When you open a file that is stored 
on Microsoft SkyDrive, the file opens in its corresponding Office 

Web App, which is a simplified version of Word, Excel, PowerPoint, 
or OneNote. Office Web Apps open within the Web browser. 
Because these programs are online, they take up no computer disk 
space. Using Office Web Apps, users can upload, create, edit, and 
share Microsoft Office documents directly within a Web browser. 
You are connected to SkyDrive when you log into your computer 
using your Windows account. You can find more information in 
the “Working in the Cloud” appendix.

Microsoft SkyDrive and Microsoft Office Web Apps
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Table A-3: Save As dialog box buttons

button use to

Back Navigate back to the last location shown in the Address bar 

Forward Navigate to the location that was previously shown in the Address bar

Up to Navigate to the location above the current location in the folder hierarchy (Windows 8 only)

Organize Open a menu of commands related to organizing the selected file or folder, including Cut, Copy, Delete, 
Rename, and Properties

New folder Create a new folder in the current folder or drive

Change your view Change the way folder and file information is shown in the folder window in the Save As dialog box; click the 
Change your view button to toggle between views, or click the list arrow to open a menu of view options

Figure A-6: File to be saved to the Unit A folder

Your dialog box might list 
the files and folders in the 
active drive or folder here

Location of Data 
Files (yours might 

differ)

New filename

Figure A-5: Save As dialog box

Click to create a new 
folder in the active 

folder or drive

Active folder or drive

Default filename and file 
extension are selected

Folders and files 
in the active 

folder or drive 
(yours will differ)

Click to change 
the file type
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Word 2013

UNIT A

Learning 
Outcomes
•	Select text using 
the mouse

•	Use formatting 
marks

Select Text
Before deleting, editing, or formatting text, you must select the text. Selecting text involves clicking and 
dragging the I-beam pointer across the text to highlight it. You also can click in the margin to the left of 
text with the  pointer to select whole lines or paragraphs. Table A-4 describes the many ways to select 
text. CASE  You revise the memo by selecting text and replacing it with new text.

1.	 Click the Show/Hide ¶ button  in the Paragraph group
Formatting marks appear in the document window. Formatting marks are special characters that appear 
on your screen but do not print. Common formatting marks include the paragraph symbol (¶), which 
shows the end of a paragraph—wherever you press [Enter]; the dot symbol (·), which represents a space—
wherever you press [Spacebar]; and the arrow symbol (S), which shows the location of a tab stop—wher-
ever you press [Tab]. Working with formatting marks turned on can help you to select, edit, and format text 
with precision.

2. 	 Click before QST Managers, then drag the  pointer over the text to select it
The words are selected, as shown in Figure A-7. For now, you can ignore the faint toolbar that appears over 
text when you first select it.

3.	 Type Marketing Staff
The text you type replaces the selected text.

4.	 Double-click Ron, type your first name, double-click Dawson, then type your last name
Double-clicking a word selects the entire word.

5.	 Place the pointer in the margin to the left of the RE: line so that the pointer changes 
to , click to select the line, then type RE: [Tab] [Tab] Launch of new Borneo trekking tour
Clicking to the left of a line of text with the  pointer selects the entire line.

6.	 Select deep in the third line of the first paragraph, type mysterious, select remote 
villages, then type sun-kissed beaches

7.	 Select the sentence Kai Haketa is in Kuching hammering out the details. in the second 
paragraph, then press [Delete]
Selecting text and pressing [Delete] removes the text from the document.

8.	 Click , then click the Save button  on the Quick Access toolbar
Formatting marks are turned off, and your changes to the memo are saved. The Show/Hide ¶ button is a 
toggle button, which means you can use it to turn formatting marks on and off. The edited memo is 
shown in Figure A-8.

steps

You deselect text by 
clicking anywhere 
in the document 
window.

QUICK TIP

If you delete text by 
mistake, immediately 
click the Undo button 
on the Quick Access 
toolbar to restore the 
deleted text to the 
document.

TROUBLE

Always save before 
and after editing 
text.

QUICK TIP
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Table A-4: Methods for selecting text

to select use the pointer to

Any amount of text Drag over the text

A word Double-click the word

A line of text Move the pointer to the left of the line, then click

A sentence Press and hold [Ctrl], then click the sentence

A paragraph Triple-click the paragraph or double-click with the pointer to the left of the paragraph

A large block of text Click at the beginning of the selection, press and hold [Shift], then click at the end of the 
selection

Multiple nonconsecutive selections Select the first selection, then press and hold [Ctrl] as you select each additional selection

An entire document Triple-click with the pointer to the left of any text; press [Ctrl][A]; or click the Select button 
in the Editing group on the Home tab, and then click Select All

Figure A-8: Edited memo with replacement text

Replacement text

Figure A-7: Text selected in the memo

Selected text

Left document margin
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Word 2013

UNIT A

Learning 
Outcomes
•	Apply bold to text
•	Increase the font 
size of text

•	Print a document

Format Text Using the 
Mini Toolbar and the Ribbon
Formatting text is a fast and fun way to spruce up the appearance of a document and highlight important 
information. You can easily change the font, color, size, style, and other attributes of text by selecting the text 
and clicking a command on the HOME tab. The Mini toolbar, which appears above text when you first 
select it, also includes commonly used text and paragraph formatting commands. CASE  You enhance 
the appearance of the memo by formatting the text using the Mini toolbar. When you are finished, you preview 
the memo for errors and then print it. 

1.	 Select Quest Specialty Travel 
The Mini toolbar appears over the selected text, as shown in Figure A-9. You click a formatting option on 
the Mini toolbar to apply it to the selected text. Table A-5 describes the function of the buttons on the Mini 
toolbar. The buttons on the Mini toolbar are also available on the Ribbon.

2.	 Click the Increase Font Size button  on the Mini toolbar six times, then click the Bold 
button  on the Mini toolbar
Each time you click the Grow Font button the selected text is enlarged. Applying bold to the text makes 
it thicker.

3.	 Click the Center button in the Paragraph group on the HOME tab
The selected text is centered between the left and right margins.

4.	 Select TO:, click , select FROM:, click , select DATE:, click , select RE:, then click 
Bold is applied to the memo header labels. 

5.	 Click the blank line between the RE: line and the body text, then click the Bottom 
Border button  in the Paragraph group
A single-line border is added between the heading and the body text in the memo. 

6.	 Save the document, click the File tab, then click Print
Information related to printing the document appears on the Print screen in Backstage view. Options for 
printing the document appear on the left side of the Print screen and a preview of the document as it will 
look when printed appears on the right side, as shown in Figure A-10. Before you print a document, it’s a 
good habit to examine it closely so you can identify and correct any problems. 

7.	 Click the Zoom In button  on the status bar five times, then proofread your document 
carefully for errors 
The document is enlarged in print preview. If you notice errors in your document, you need to correct them 
before you print. To do this, press [Esc] or click the Back button in Backstage view, correct any mistakes, save 
your changes, click the File tab, and then click the Print command again to be ready to print the document.

8.	 Click the Print button on the Print screen
A copy of the memo prints using the default print settings. To change the current printer, change the num-
ber of copies to print, select what pages of a document to print, or modify another print setting, you simply 
change the appropriate setting on the Print screen before clicking the Print button. 

9.	 Click the File tab, then click Close
The document closes, but the Word program window remains open.

steps

If the Mini toolbar 
disappears, right-
click the selection to 
display it again.

TROUBLE

Click the Decrease 
Font Size button 
to decrease the 
font size.

QUICK TIP

You can customize 
your Quick Access 
toolbar to include 
the Quick Print but-
ton, which prints a 
document using the 
default print settings. 

QUICK TIP
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Table A-5: Buttons on the Mini toolbar

button use to button use to

Change the font of text Apply bold to text

Change the font size of text Italicize text

Make text larger Underline text

Make text smaller Apply colored highlighting to text

Copy the formats applied to selected 
text to other text

Change the color of text

Apply a style to text Apply bullets to paragraphs

Apply numbering to paragraphs

Figure A-10: Preview of the completed memo

Print 
command

Options for 
changing the 
default print 

settings

Text is bold

Bottom border added 
between heading and 
body text

Text is enlarged, 
bold, and centered

Preview of how 
document will look 
when printed

Figure A-9: Mini toolbar

Bottom Border buttonCenter button

Mini toolbar

Bold button on Ribbon 
and Mini toolbar
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UNIT A

Learning 
Outcomes
•	Search for 
templates

•	Customize a 
template

•	Use content 
controls

Use a Document Template
Word includes many templates that you can use to create letters, reports, brochures, calendars, and other 
professionally designed documents quickly. A template is a formatted document that contains place-
holder text and graphics, which you replace with your own text and graphics. To create a document that 
is based on a template, you use the New command on the File tab in Backstage view, and then select a 
template to use. You can then customize the document and save it with a new filename. CASE  You 
use a template to create a cover letter for a contract you will send to the Rainforest Hotel in Kuching. 

1.	 Click the File tab, then click New
The New screen opens in Backstage view, as shown in Figure A-11. You can select a template from this win-
dow, or search for other templates.

2.	 Click Letters in the Suggested Searches section
A gallery of letter templates opens in the New screen.

3.	 Scroll down until you find the Cover Letter (aligned) thumbnail on the New screen, click 
it, preview the template in the preview window that opens, then click Create
The Cover Letter (aligned) template opens as a new document in the document window. It contains place-
holder text, which you can replace with your own information.

4.	 Click the Ribbon Display Options button on the title bar if the Ribbon is not displayed, 
click Show Tabs and Commands, then click [Click to select a date] in the document
The placeholder text is selected and appears inside a content control. A content control is an interactive 
object that you use to customize a document with your own information. A content control might include 
placeholder text, a drop-down list of choices, or a calendar. 

5.	 Click the [Click to select a date] list arrow
A calendar opens below the content control. You use the calendar to select the date you want to appear on 
your document—simply click a date on the calendar to enter that date in the document. 

6.	 Click the Today button on the calendar
The current date replaces the placeholder text.

7.	 Click [Recipient Name], type Ms. Yana Roy, click [Title], type Manager, click [Company 
Name], type Rainforest Hotel, click [Street Address], type P.O. Box 4397, click [City, ST 
Zip Code], then type Kuching 93100, Malaysia
You do not need to drag to select the placeholder text in a content control, you can simply click it. The text 
you type replaces the placeholder text.

8.	 Click [Recipient], type Ms. Roy, click the body text placeholder text, then type Enclosed 
please find a copy of our contract for the Borneo Explorer Trek tour. We look forward to 
working with you. 
The text you type replaces the placeholder text in the greeting line and in the body text of the letter.

9.	 If the name in the signature block is not your name, drag to select the text, then type 
your name, as shown in Figure A-12

When the document is created, Word automatically enters the user name identified in the Word Options 
dialog box in the signature block and in the content control in the upper-left corner of the page. This text 
is not placeholder text, so you have to drag to select it. 

steps

You must have an 
active Internet con-
nection to search for 
templates.

QUICK TIP

Templates change 
over time. If this tem-
plate is not available, 
select another Cover 
Letter template or 
just read the steps to 
understand how to 
work with templates.

TROUBLE

You can delete any 
content control by 
right-clicking it, and 
then clicking Remove 
Content Control on 
the menu that opens.

QUICK TIP

10.	  Click the File tab, click Save As, then save the document as WD A-Rainforest Letter to 
the location where you store your Data Files
The document is saved with the filename WD A-Rainforest Letter.
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Word remembers the editing and formatting changes you make so 
that you can easily reverse or repeat them. You can reverse the last 
action you took by clicking the Undo button  on the Quick 
Access toolbar, or you can undo a series of actions by clicking the 
Undo list arrow  and selecting the action you want to reverse. 
When you undo an action using the Undo list arrow, you also undo 
all the actions above it in the list—that is, all actions that were 
performed after the action you selected. Similarly, you can keep the 
change you just reversed by using the Redo button  on the 

Quick Access toolbar. The Redo button appears only immediately 
after clicking the Undo button to undo a change.

If you want to repeat an action you just completed, you can 
use the Repeat button  on the Quick Access toolbar. For 
example, if you just typed “thank you,” clicking  inserts 
“thank you” at the location of the insertion point. If you just 
applied bold, clicking  applies bold to the currently 
selected text. You also can repeat the last action you took 
by pressing [F4]. 

Using the Undo, Redo, and Repeat commands

Figure A-11: New screen in Backstage view

Click to open an 
existing document

Types of templates 
available with an 

Internet connection

Click to create a new 
blank document

Search for a template
Your templates may differ

Figure A-12: Document created using the Cover Letter (aligned) template

Placeholder text is replaced 
with customized text
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UNIT A

Learning 
Outcomes
•	Remove a content 
control

•	Zoom and scroll 
a document

•	Use Word 
document views

Navigate a Document
The Word Zoom feature lets you enlarge a document in the document window to get a close-up view of a 
detail or reduce the size of the document in the document window for an overview of the layout as a 
whole. You zoom in and out on a document using the tools in the Zoom group on the View tab or you 
can use the Zoom level buttons and Zoom slider on the status bar. CASE  You find it is helpful to zoom 
in and out on the document as you finalize the letter. 

1.	 Click your name in the upper-left corner of the document, right-click the Your Name 
content control, click Remove Content Control on the menu that opens, select your 
name, click the Decrease Font Size button  on the Mini toolbar three times, type 
Quest Specialty Travel, click Job Title, press [Backspace] twice, click Job Title, then press 
[Backspace] twice
Removing the content control from your name changes the text to static text that you can replace with 
other text. Pressing [Backspace] removes the Job Title placeholders.

2.	 Drag the vertical scroll box down until the bottom of the page is visible in your 
document window 
The scroll arrows or scroll bars allow you to scroll through a document. You scroll through a document 
when you want to display different parts of the document in the document window. You can also scroll by 
clicking the scroll arrows above and below the scroll bar, or by clicking the scroll bar.

3.	 Click [Website] to move the insertion point to the bottom of the page, click the View 
tab, then click the Page Width button in the Zoom group
The document is enlarged to the width of the document window. When you enlarge a document, the area 
where the insertion point is located appears in the document window. 

4.	 Click [Address 1], then replace the placeholder text with the text shown in Figure A-13 
The text you type replaces the placeholder text. You do not always need to replace the placeholder text with 
the type of information suggested in the content control. 

5.	 Click the Zoom level button  on the status bar
The Zoom dialog box opens. You use the Zoom dialog box to select a zoom level for displaying the docu-
ment in the document window. 

6.	 Click the Whole page option button, then click OK
The entire document is displayed in the document window. 

7.	 Click Quest Specialty Travel to move the insertion point to the top of the page, then 
move the Zoom slider to the right until the Zoom percentage is 100%
Dragging the Zoom slider to the right enlarges the document in the document window. Dragging the zoom 
slider to the left allows you to see more of the page at a reduced size. You can also move the Zoom slider by 
clicking a point on the Zoom slide, or by clicking the Zoom Out and Zoom In buttons. 

8.	 Click the Read Mode button  on the status bar
The document appears in the document window in Read Mode view. Read Mode view hides the tabs and 
ribbon to make it easier to read documents on screen. Read Mode view is useful for reading long documents. 

9.	 Click the Print Layout view button  on the status bar to return to Print Layout view, 
click the Zoom In button  on the status bar twice, then save the document
The completed cover letter is shown in Figure A-14. 

steps

If you do not see the 
vertical scroll box, 
move the pointer to 
the right side of the 
document window 
to display it.

TROUBLE

You can also click the 
Zoom button in the 
Zoom group on 
the View tab to open 
the Zoom dialog box.

QUICK TIP

You can also click 
VIEW on the menu 
bar, then click Edit 
Document to return 
to Print Layout view.

QUICK TIP

10.	  Submit the document to your instructor, close the file, then exit Word
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Figure A-14: Completed letter

Figure A-13: Zoom slider

Document views are different ways of displaying a document in 
the document window. Each Word view provides features that 
are useful for working on different types of documents. The 
default view, Print Layout view, displays a document as it will 
look on a printed page. Print Layout view is helpful for format-
ting text and pages, including adjusting document margins, 
creating columns of text, inserting graphics, and formatting 
headers and footers. Also useful is Read Mode view, which 
displays document text so that it is easy to read on screen. 
Other Word views are helpful for performing specialized tasks. 
Web Layout view allows you to format Web pages or 
documents that will be viewed on a computer screen. In Web 

Layout view, a document appears just as it will when viewed 
with a Web browser. Outline view is useful for editing and 
formatting longer documents that include multiple headings. 
Outline view allows you to reorganize text by moving the 
headings. Finally, Draft view, shows a simplified layout of a 
document, without margins, headers and footers, or graphics. 
When you want to quickly type and edit text, it’s often easiest to 
work in Draft view. You switch between views by clicking the 
view buttons on the status bar or by using the commands on 
the View tab. Changing views does not affect how the printed 
document will appear. It simply changes the way you view the 
document in the document window. 

Using Word document views

Replace placeholder 
text with this text Zoom slider 

at 154%
Zoom level 
button at 154%
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